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2 Ruskin

Ruskin is the RBR software that manages your RBR loggers to provide all the data necessary to do your work. Ruskin 
provides a graphical user interface that makes using the loggers easy. You can use Ruskin to do the following:

• configure, schedule and enable multiple loggers
• download data after logging
• graphically view data sets
• export data in various formats
• change the calibration coefficients for your logger

Ruskin can be used on PC and Mac.
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3 Revision history

Revision 
No.

Release Date Notes

1.0 7-Oct-2011 Original

2.0 15-Oct-2012 Adding RBRvirtuoso and RBRconcerto, and new features

2.1 28-Jan-2013 Adding thresholding and AMT pH calibration, editing 
autoranging, thumbnail view, parameters tab, file export, 
event button, and calibration

3 26-Jun-2013 Initial controlled release, new part #, no other changes

4 22-Jul-2013 Ruskin v1.8.3 additions

5 02-Sep-2014 Migrated to new editing system, updated for Ruskin 
v1.8.20

6 22-Dec-2014 Added auxiliary controls

7 12-Jan-2015 Added bursting controls

B 12-Sept-2017 Final revision for standard loggers

C 02-Feb-2018 Logger 3 features

D 12-Dec-2018 Updated installation details, updated screenshots, added 
auto-deploy features

E 13-Mar-2019 Updated plotting information, firmware upgrades, and 
screenshots
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4 Warranty statement

All data loggers manufactured by RBR Ltd. are warranted against defects in workmanship or original parts and 
materials for one year. Third party sensors (not manufactured by RBR) are limited to the warranty provided by the 
original manufacturer.

Units suffering from such defects will be repaired or replaced at the discretion of RBR Ltd., provided that the problem 
has appeared during normal use of the instrument for the purpose intended by us. The liability of RBR Ltd. extends only 
to the replacement cost of the instrument. The customer will bear all costs of shipment to us for repair; all other costs, 
including return shipment, will be borne by RBR Ltd.

This warranty does not cover consumables or normal wear and tear, nor does it cover damage caused by negligent use 
or mishandling. Attempted modification or repair of any unit without the prior consent of RBR Ltd. will immediately 
void any warranty in force.

Users are expected to maintain a regular program of calibration.

We reserve the right to grant or refuse warranty repairs at our discretion if we consider that there are reasonable 
grounds for doing so.
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5 Introduction
This document introduces you to Ruskin and helps you to use it effectively from the start. It is written specifically for the 
RBRvirtuoso3, RBRduo3, RBRconcerto3, and RBRmaestro3 loggers.

You can access the Ruskin User Guide on the USB data stick provided when you purchase a logger, from the Help menu 
in Ruskin, and on the RBR web site, at www.rbr-global.com.

Release notes are automatically displayed each time you install an updated version of Ruskin. The most recent release 
notes are also available from the Help menu in Ruskin.For information about operating and maintaining your data 
logger, see the Logger Hardware section. It helps explain how to change the battery and change desiccant, including 
other useful information, such as inspecting and replacing O-rings.
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6 Installation

6.1 Install Ruskin on a PC
You can install Ruskin on a PC that runs the Windows 7, 8, 8.1, or 10 operating system.

The minimum requirements for Ruskin are:

• OS = Windows 7
• Processor speed = 1.4GHz 
• RAM required = 1GB 
• Display resolution = 1024x768 recommended 
• HDD space for installation = 300MB

Steps

1. Connect the data stick included with your instrument to a USB port.
2. Navigate to the folder Ruskin Installation and double click on the file RuskinSetup.exe.
3. Follow the installation wizard. By default, Ruskin will be installed to C:\RBR.
4. The logger uses a USB interface to communicate with Ruskin.

At the end of the installation, a prompt will appear asking, "Would you like to install the logger driver 
at this time?"

5. Click Yes to install the drivers.

A shortcut to Ruskin appears on the desktop and in a Start menu folder called Ruskin.

6.2 Install Ruskin on a Mac

You can install Ruskin on a Mac running OS X 10.5 (Leopard) or later.

Steps

1. Insert the USB data stick in the appropriate USB port.
2. Navigate to the folder OSX and double click on the file Ruskin.dmg.
3. When the disk image window opens, drag the Ruskin icon into the applications directory and wait for 

the copy to complete.
4. To open Ruskin for the first time navigate to your applications directory, locate Ruskin, right click on 

the icon, and select Open.

You may need to run the setup application as an administrator to install the driver correctly.

Please note that the most recent version of Ruskin can be found at https://rbr-global.com/products/software

https://rbr-global.com/products/software
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5. The dialogue box shown below will prompt you to authorize the opening of Ruskin. 

An application named Ruskin appears in the Applications folder.

You may want to drag the Ruskin.app application to the Dock.

6.3 Update Ruskin
To take advantage of new features and bug fixes, ensure that you are using the most recent version of Ruskin.

It is not necessary to uninstall an older version of Ruskin before installing a newer version. The installation program 
deletes the older files before installing the newer ones. It does not delete any Ruskin data files or log files.

The most recent version of Ruskin is always available on the RBR website (www.rbr-global.com). However, if you 
already have an older version of Ruskin installed, Ruskin automatically notifies you that a newer version is available 
when you start Ruskin. You can check to see if a new version is available from within Ruskin navigating to the 
menu Help > Check for updates. If you have a broadband connection, we recommend that you follow the installation 
instructions that appear on your computer. Otherwise, request a USB stick from RBR.  

6.4 Uninstall Ruskin
If you no longer need to manage RBR instruments from your computer, you can uninstall Ruskin.

It may be required that you navigate to System Preferences > Security & privacy to allow apps downloaded 
from “Anywhere” to complete the installation.



Although you can specify a different folder for the working directory for the software, we recommend that you 
use the default Applications folder.



If you do not have a broadband connection and/or are unable to install the Ruskin updates, update 
notifications are available via email. To receive these notifications, send an email to: support@rbr-global.com
subject: "Ruskin update request".



http://rbr-global.com/support/software
mailto:support@rbr-global.com?subject=Ruskin%20update%20request


RBR#0006105revE  –  13

It is not necessary to uninstall an older version of Ruskin before installing a newer version. The installation program 
deletes the older files before installing the newer ones. For more information, see Update Ruskin.

Windows 7, 8, 8.1, or 10

Go to Start > Control Panel > Programs, and under Programs and Features, click Uninstall a program. In the list, 
locate Ruskin – click Ruskin to highlight it, and then click Uninstall.

OS X 10.5 or later

Move the Ruskin application from Applications to the Trash.

Removing Ruskin will not delete your data files or your diagnostic logs.
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7 Provide your feedback
You can get in touch with RBR in several different ways:

• Send us an email.  For a technical question, write to support@rbr-global.com. For general inquiries, 
use info@rbr-global.com.

• Send us a bug report from within Ruskin itself.  Use the Help menu > Comment on Ruskin.  
This allows you to include the diagnostic logs, and any other files (RSK datasets, screenshots) that will 
help us reproduce the problem and help you as quickly as possible.

Steps

1. From the Help menu, click Comment on Ruskin.
The Feedback to RBR dialog box appears.

2. Enter your identification information, for example, email address and name, and then summarize 
your comments. 

3. Provide a detailed description and add any attachments, if required. 
4. Click Submit to submit the report. 

mailto:support@rbr-global.com
mailto:info@rbr-global.com
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8 Quick start

8.1 Deploy an instrument
Before you begin using your RBR loggers, you may want to experiment with the simulated loggers that are included in 
Ruskin. For instructions on simulating a logger, see Using a simulated logger.

When you are ready to use your own RBR loggers, we recommend that you follow the following steps to ensure that you 
measure exactly what you want on the first attempt. 

Steps

• To establish communication between the logger and a computer, remove the battery end cap and 
locate the USB-C connector, just below the battery cover. The supplied interface cable is plugged into 
this connector. The USB-C connector can be inserted with either side facing up.

• The logger should appear in the Navigator view after a few seconds.
• If you are using the logger for the first time, you can use either the default preferences or specify your 

preferences to apply to all your loggers. For more information, see Preferences. You can change these 
preferences at any time.

• Click the logger that you want to use. Ensure that it contains the sensors you expect to find on the 
logger by viewing the Information tab in the Properties view on the right side of the Ruskin window. 
For more information, see View information about a logger.

If you want to see live data sampled every few seconds but not saved, select the Fetching button in the toolbar located 
above the Plot view. The Plot view is located at the bottom of the Ruskin window.

• Click the Configuration tab to specify streaming.

• If you want to view or modify calibration coefficients, click the Calibration tab. For more information, 
see Calibration tab.

• Click the Configuration tab > Sampling section to schedule the logger to take samples when and as 
often as you want within the limits of your logger.
 For more information, see Schedule a logger.

Ruskin prevents you from enabling a schedule that exceeds the memory capacity of the logger. Ruskin also shows the 
estimated battery usage required to use your logger as scheduled. You should seriously consider this information 
before you enable the schedule.

• On the Configuration tab, click Enable to take samples according to the schedule that you specified. 
If you enabled streaming data, you will see the data appear immediately once the logger is enabled in 
the Plot view toolbar.

• If you want to download data, click the Download button from the Configuration tab to download all 
the data saved since your schedule was enabled. For more information, see Download. The focus 
changes to the new dataset in the Navigator view, and the static data appears in the Plot view. You 
can now export the downloaded data to a file in Excel or text. You can also save the image as a PDF or 
PNG file for viewing outside Ruskin.

You must specify your preferences regarding these features before you enable the schedule. For more 
information, see Configure a logger.


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8.2 Using a simulated logger
Ruskin can simulate most logger types that RBR produces. We recommend that you experiment with your type of 
simulated logger before enabling a schedule for your actual RBR logger. This practice helps you become more familiar 
with how an RBR data logger interacts with Ruskin and how to configure the settings and features within Ruskin. 

Configuring a simulated logger

1. From the Instruments menu, click Simulate instrument. 
The Configure Simulated Instrument dialog box appears.

2. Click on the tab that correlates to your logger's family type. 
For example, if simulating an RBRvirtuoso3, you would select the Standard Instruments tab.

3. Select from the information provided within the logger's tab.  
4. Click OK. 

The simulated logger appears under Instruments in the Navigator view.
5. Go to the Navigator view and click the new simulated logger to see the general information and 

configuration settings in the Properties window. 

You can now work with this logger the same way as you work with a real RBR logger, including: configuring, calibrating, 
and fetching data. Currently simulated instruments cannot be enabled or downloaded. For more information, 
see Deploy an instrument.

Multiple loggers, both real and simulated, can be listed in your Navigator window.

8.3 View information about a logger

You can view static information about a logger at any time as follows:

In the Navigator view, click the appropriate logger.

 The Information tab in the Properties window on the right side of Ruskin identifies the logger. Its general information 
such as model, serial number, generation, firmware version, battery status, and the channels.

If you want to remove a simulated logger, in the Navigator window, right-click the logger and click Remove 
simulated instrument. You can also use the Instruments menu.


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8.4 Recover an instrument and download data
When the deployment is complete recover your instrument and follow these steps to download your data.

Steps

• Start Ruskin
• Carefully open the battery end cap of the logger 
• Insert the USB-C connector into the logger and connect the cable to your computer
• The logger appears in the navigator window and select the Configuration tab and select Download...

(see Download)
• Save the file to a preferred location
• Evaluate your data (see Analysis) 

8.5 Data format
Data can either be streamed from an instrument (requires a deployment to be enabled) or it can be fetched from the 
instrument.

Realtime data can be formatted in a limited number of formats as described below. Each format is listed alongside and 
an example output for an RBRconcerto3 C.T.D: 

Output format 
option

Instrument 
setting

Example data

Standard 
resolution

caltext01 2018-12-10 13:06:38.000, 0.0005, 
22.9536, 10.1149

Flooded loggers may be under pressure and opening a logger may be dangerous - take precautions when 
opening a logger


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Output format 
option

Instrument 
setting

Example data

Standard 
resolution (units)

caltext02 2018-12-10 13:06:38.000, 0.0005 mS/cm, 
22.9536C, 10.1149 dbar

Highest resolution 
(RBRquartz)

caltext03 2018-12-10 13:06:38.000, 
0.000525642944, 22.939636, 10.1149120

Engineering caltext04 2018-12-10 13:06:38.000, 
525.642944e-006, 22.9396360e+000, 
10.1149120e+000

The output format can be changed in Ruskin from the instrument's Configuration tab. There is a drop down menu item 
called format in the Options section.

• Standard resolution
• All data values are shown to 4 decimal places

• Standard resolution (units)
• All data values are shown to 4 decimal places
• Following the value, and separated from it by a space, is a short string representing the units of 

measurement.
• Highest resolution (RBRquartz)

• All values are shown with enough significant digits ensuring no loss of resolution.
• Engineering

• All values are shown in 'engineering-notation' floating point (same as scientific notation except 
that the exponents are constrained to be multiples of three) with enough significant digits 
ensuring no loss of resolution.

The values following the timestamp are all the enabled channels. To identify which channels are enabled and their 
order in the string you can use the command outputformat channellist.

Example:

>> outputformat channelslist

<< utputformat channelslist = conductivity(mS/cm)|temperature(C)|pressure(dbar)
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8.6 Ruskin Mobile

8.6.1 Connecting over Wi-Fi to a mobile device
Install the Ruskin App on your mobile device by going to the Apple App store or Google Play.

Steps

1. Twist ON/Off on the logger end cap to activate the Wi-Fi. 
You may need to Twist the logger either to the ON position or OFF position to activate the Wi-Fi, but 
remember to twist to the OFF position to pause the logger.

The twist activation is intended to start sampling or pause sampling, however twisting ON or OFF also 
enables the Wi-Fi module to transmit. This is the method to activate the Wi-Fi if it is not active.


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2. The Android app will automatically scan Wi-Fi networks for any instruments. On iOS you must connect 
to the instrument in your Wi-Fi settings. There is a convenience button on the landing page as shown 
below. The logger should appear automatically under "Choose a network..." The name appears as the 
RBR serial number of the logger. Tap it to connect to the instrument. Please allow your iPhone to 
connect before you exit the Settings screen, i.e. that a blue check mark appears to the left of the Wi-Fi 
network.

 

3. Exit Settings to return to the Home screen. 
4. From the Home screen, tap the Ruskin App (the App will automatically search for the logger and 

connect to it).

The Wi-Fi is disabled after 60 seconds of inactivity. Twist the logger ON or OFF to activate the Wi-Fi.
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After connecting to the logger, you are automatically in the Instrument view of the app. The different views you can go 
to are Instrument, Datasets and Settings, located at the bottom of the screen. Tap Datasets to view a list of local 
datasets, and (optionally) remote datasets you have stored in your Dropbox account. This is also how you can share/
upload and view your data, explained more later.

8.6.2 Instrument Tab
When connected to an instrument, the top of the Instrument tab shows the status of the logger indicating whether it is 
currently logging samples, how many samples have been taken, and what the sampling rate is set to. The sampling rate 
can only be changed when the deployment has been stopped as shown below - note that the right most frequency 
indicator has become a picker.

The logging state (ON/OFF) in the example below, controlled by twisting the instrument end cap to an ON or OFF 
position, should not be confused with starting / stopping a deployment, controlled using the red START / STOP button 
in the lower right corner of the Instrument tab. This is explained more later.
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Real-time Data
A sparkline chart shows the last 50 readings for each of the measured channels (or the last 150 readings when using a 
tablet). These are typically out-of-water samples and serve to provide real-time feedback from the instrument. To view 
charts of the full deployment, tap the light blue "VIEW" button beneath the sparkline.

Geotagging
Your logger does not have a GPS - location information for the logger is gathered using your phone / tablet's location 
capabilities.

The "LAST TAGGED LOCATION" in the center of the Instrument tab, indicates when the last GPS coordinates were added 
to the dataset. Whenever the mobile app connects to an instrument it automatically logs the location in the dataset. 
The location is taken at the time of connection, so should a download take several minutes and the boat be moving, the 
initial location is captured. Should a more accurate location fix be attained within the first minute after connection, 
those coordinates are used instead.
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As the app uses GPS, a clear view of the sky will typically lead to a more accurate waypoint, rather than downloading 
inside a ship cabin for example. To conserve the battery life of your phone, GPS tracking only occurs when the Ruskin 
app is open, but this means that sometimes it can take a few moments to get an accurate location fix.

A GPS waypoint fix can also be manually added at any time by tapping on the purple "TAG" button. The last tagged 
location will be updated to indicate the coordinates and accuracy of the manual waypoint.

Channels

Scrolling to the bottom of the Instrument tab reveals the instrument's Measured and Derived Channel lists along with 
their units of measurement. The colored circle to the left of each channel indicates the sparkline color used to represent 
the latest readings from that channel.

8.6.3 Starting or Stopping a Deployment
The red button in the bottom right corner reads either START or STOP. If a deployment has been started the STOP 
button ends that deployment, and likewise, if a deployment has been stopped, the button reads START to begin a new 
deployment.

When a new deployment is started, the data on the instrument will be erased. Also, once a deployment has been 
stopped, it can not be resumed - a new deployment must be started, wiping the data on the instrument.

One dataset is created for each deployment. Deployments are typically long running, consisting of many sampling 
periods (by twisting the end cap to ON) and paused periods (by twisting the end cap to OFF). 
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While a deployment is stopped, the sampling rate can be adjusted as described earlier. A deployment can only have one 
sampling period, thus once the deployment begins, the sampling rate picker in the top right corner of the Instrument 
tab can no longer be changed.

Whilst the deployment is stopped, twisting the instrument to either ON or OFF will activate the Wi-Fi, but the instrument 
will not buzz as the instrument is not sampling.

From Ruskin Desktop, when you start a deployment, you are given the option to do so in an "EasyParse (mobile) 
compatible" mode, or in a more complex mode where calibration data is segregated. If the existing deployment is not 
in the EasyParse (mobile) mode, the mobile app can still download the data, but the app will not display a sparkline, 
nor will users be able to view charts.

When starting a new deployment from the mobile app, the new deployment is always set to the EasyParse (mobile) 
mode, regardless of the previous deployment's mode.

Clock Sync
When you start a deployment, you can automatically set the instrument's time. The time is taken from your phone / 
tablet. As the instrument has a clock but no concept of time zones, you may choose to use UTC or local time, or you 
may choose to set no time at all. Note that should you leave the logger without batteries for more than a few seconds, 
the clock will reset (back to the epoch). Starting a new deployment with this setting enabled provides a convenient way 
to correct the clock.
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8.6.4 Accessing Datasets

Datasets are separated into 2 lists - datasets that are locally stored on your device (from instrument downloads 
performed on this phone / tablet), and "Archived Datasets" that are stored on Dropbox. If you have not set-up Dropbox, 
the second list will not appear. Note that there are a number of ways datasets can be uploaded from your device - you 
do not necessarily need to use Dropbox. Setting-up Dropbox and using other means of sharing datasets is explained 
later.

A sample dataset, captured from a real deployment, is also available to demonstrate features of the app.

If an instrument deployment was started from Ruskin Desktop, and the user opted not to use the EasyParse (mobile) 
mode, the dataset icon will include an exclamation mark.
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You can view charts for datasets stored locally on your device. You can NOT view charts for datasets that have been 
archived to Dropbox and removed from your device. For this reason you may or may not choose to automatically 
remove local datasets once you have uploaded them (explained in the Dropbox section).

Uploading and Sharing Datasets
On iOS, swiping to the left on an item in the Datasets list will reveal some operations that can be performed on that 
dataset. On Android, long-pressing the item reveals the equivalent context menu.

The "Share" option shows a context menu of the available share options for that dataset. These are only available for 
local datasets. What these are, depends on the apps you have installed on your phone, but a number of options come 
without additional apps. On iOS these include sharing by email, AirDrop, and save to Files (as of iOS 11). If you would 
like to see your cloud drive (Google Drive, Baidu, Box, Microsoft OneDrive, iCloud, Dropbox etc.) you need to install that 
app, after which it should be available as a share destination.

Dropbox
There are additional features available for Dropbox sharing, that incidentally don't require the Dropbox app to be 
installed. You can bulk upload your Datasets to Dropbox. To enable Dropbox integration, you must sign in to Dropbox. 
The option for this is at the top of the Settings tab.

Once signed in to Dropbox you can press the cloud button in the top right corner of the Datasets tab to bulk upload all 
your local datasets. As the datasets upload, the icon will transition from an upwards arrow to a check-mark.
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You can choose to automatically delete the datasets from your device once they have been uploaded. The preference 
for this, which by default is set to delete the local copy, can be found in the Settings tab.

8.6.5 Charting
Selecting the blue "VIEW" button under the Sparkline will show charts for the connected instrument's existing 
deployment. Charts for any local datasets can also be viewed by tapping on that dataset in the Datasets list. The charts 
are separated into casts, that is, each time the instrument descends and ascends again is considered to be a cast, and 
one chart is created for each cast.

In the example below, there are 29 casts (pages). Swipe left and right to view the chart for each cast. Note that when 
testing the out-of-water samples, there will only be one chart as the instrument determines the start and end of casts 
by depth (pressure) readings.  
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In portrait orientation, channel data is plotted by depth. Only downcast data is plotted - the upcast data is omitted. As 
the instrument sensors face downwards, the downcast provides the most accurate data - upcast data can be subtly 
impacted by the turbulence from the leading instrument housing on the ascent.

When viewing out of water samples, the Downcast chart will appear like a random plot. Only once used in a real cast 
will the true usefulness of this plot become apparent, as illustrated above.

In landscape orientation, the channel data is plotted by time. Depth is inverted so the bottom reading on the chart 
intuitively represents the bottom of the cast.

Pinch-to-zoom in on data. The chart axes adjust relative to each other on zooming and panning around the chart so 
that all chart series occupy the full height or width of the chart and can be easily compared side-by-side.

The Details drawer, shown by tapping the top-right corner, reveals data about the displayed cast and the deployment. 
The deployment data is also available in the "Info" context menu of the Datasets list.
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You can set some chart viewing preferences. In the Settings tab you can opt to have your charts plot temperature by 
Celsius (default) or Fahrenheit, and whether depth is plotted as metres (default), feet or fathoms. This is purely a 
viewing preference for your phone / tablet and in no way changes the units in which the data is captured in the dataset.
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9 Configure a logger
Before you enable a logger schedule, you can configure the logger to suit your requirements.

The instructions to configure a |tide or |wave logger are different than the standard loggers and can be found in Tides 
and Waves.

If your logger schedule is already enabled when you decide to change the configuration you must stop running the 
schedule, make your changes, and enable the schedule again. However, any data stored so far on the logger will be 
lost.

Within the Configuration tab the Enable, Revert settings, and Use last setup buttons are found. When you 
click Enable, the logger setup parameters are stored to the logger and the schedule is enabled. When you click Revert 
settings, you set the logger configuration back to previous settings. 

Use last setup is intended for configuring multiple loggers using the same schedule. For example, to set up three |tide 
loggers with exactly the same parameters, set one logger up and enable it; connect the second and third logger and 
when you click Use last setup button, these two loggers will be set up with the same parameters as the first logger. This 
includes the logger clock time, start and end logging times, sampling period (or rate), gating condition, and tide or 
wave sampling parameters for |tide or |wave loggers.

9.1 Overview of the Configuration tab

Group Field Explanation

Schedule You can configure multiple settings that include when the 
logger starts and stops logging, what type of sampling regime 
takes place, and the type of measurements speed.

For more information about scheduling a logger, see Schedule 
a logger.

Status Indicates the loggers current state (Not enabled, Logging in 
progress, Paused).

Clock The loggers current clock. Buttons for syncing to the 
computers clock or to the computers clock adjusted to UTC.

Start/End The programmed start time and the estimated end time based 
on available memory or power.

You can preserve the data by downloading it to a file before you enable the schedule again.
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Group Field Explanation

Realtime For more information about real time data configuration, see 
Fetching and streaming date.

Format You can configure settings for obtaining real time data from 
your logger (provided it is equipped with an external data 
port). You can select one of the four live data output formats.

Serial You can specify the Baud rate for serial communication.

Mode Serial communication protocol.

Power Internal You can specify the type of internal battery used for the 
deployment estimator.

The logger tracks how many samples have been taken since 
the Fresh box has been checked and estimates based on the 
remaining potential samples.

External You can specify the type of external power supply used for the 
deployment estimator.

Extended 
battery 
endcap

You can specify if this instrument is configured with an 
extended battery endcap in order to get more accurate 
autonomy figures for the sampling regime specified.

Sampling Mode You can toggle between Continuous, Average or Burst 
sampling. See Averaging or Bursting.

Speed/
Rate

Sampling speed is >1sec or check the Rate box to select <1sec 
sampling.

Gate For information about enabling twist action, see Twist 
Activation.

For information about wet switch settings, see wet switch.
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Group Field Explanation

Options Realtime You can enable streaming data on either a USB or Serial 
connection

Format The format of realtime data

Serial You can specify the Baud rate for serial communication.

Mode Serial communication protocol.

Storage The standard format is Desktop, however, to improve the 
download speed over WiFi enabled loggers select Mobile.

Wi-Fi You can toggle on or off the Wi-Fi module to save power.

Voltage 
sensors

Channel The index of voltage channel

Latency The time (ms) required to wait after power up for the sensor to 
settle in order to take a reading

Current The amount of current (mA) the sensor requires to operate

Ranging 
sensors

Sensor The name of the sensor

Range The gain level used on the specified sensor for the deployment. 
Either a fixed gain or auto range setting

9.2 Schedule a logger
You can schedule when your loggers start logging readings and specify the sampling rate. Ruskin indicates any 
unattainable conditions in the defined schedule at the bottom of the Configuration tab, and the Enable button is 
greyed out.
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Before you enable your logger, you should verify the available settings found in the groups: Schedule, Sampling, 
Options, Voltage sensors, Ranging sensors, and Power.

Steps

1. While the logger you want is highlighted in the Navigator window, click the Configuration tab.
2. Click Local sync to set the logger time to your computer time, or select UTC sync to adjust your 

computer time to UTC time. 
3. Under Start, specify the date and time you want to start running the schedule, or select 

the Now check box. 

4. Under End, the date the logger will exhaust either the batteries or memory is specified.

5. In Sampling mode select the type of sampling required, Continuous, Average, Burst, 
Directional, Tide or Wave (as applicable).

6. In Measurement speed select either a period (one second or longer) or a rate (rate is for |fast loggers 
only).

7. Click Enable configure the logger to sample.

The display of the above tabs are based on the logger capability. Not all tabs are visible.

If you select and then clear the Now check box, you can then manually modify the current date and 
time instead of the original values.



If the gating condition is other than None, then the Start date and time cannot be set.

The Battery bar shows how long the instrument will run based on the selected battery chemistry or 
capacity, the Start logging (date and time) and the Measurement speed.
The Memory bar shows how long the instrument will run based on the memory capacity, the Start 
logging (date and time) and the Measurement speed.
The bar is shown in Red if the end time is not limited by this factor, if in Green it is the limiting factor. It 
is best to tune your Measurement speed and battery chemistry to optimize for these factors.



Average, Tide and Wave sampling are set from their respective tabs.

If the battery bar indicator is green but shows that you are close to capacity and you know that your logger will 
be operating under very cold conditions, you may want to lower the demands on the battery by lengthening 
your sampling period or opting for a different battery chemistry.


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9.2.1 Profiling |fast
All profiling loggers (known as |fast) have the ability to sample faster than one second, as well as sample in an average
or burst mode. 

Selecting Rate for a Sampling speed enables sampling speeds of 1 Hz or faster.

9.3 Stop logging
Logging stops on its own when one of the following occurs:

• The end logging time is reached.
• The power is removed.
• The logger memory is filled.
• The logger battery is depleted.

To manually stop the logger In the Properties view, click Configuration tab and select Stop logging.

9.4 Averaging
To set up a logger to average at sub-second rates (Hz) or with periods one second or greater, click Configuration tab >
Sampling section, and then select Average in the Mode drop down menu. 

There are two versions of the Average Sampling section that can be used, either simple or advanced. This option can 
be set in Preferences.

An error message appears at the bottom of the Configuration tab if the sampling period is too fast for your 
logger. This typically means that one of the sensors has a long latency.



If the Enable button is grayed out, an error message appears.
If you enable the logger, and it is not your first schedule, you will see the warning The contents of memory will 
be erased! Before proceeding, you should download the data from the logger (see Download). If you are sure 
that the information is stored, then click Erase and enable logging.



 Whether or not you make any changes to the schedule or the configuration, before running the schedule 
again, a warning appears that the contents of memory will be erased. If you want to save the data stored so far 
on the logger, you must download the data to a file before proceeding. You can do this from Properties view > 
Configuration tab and select Download. For more information about downloading a file, see Download.


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Simple form:

In the simple form only pre-defined selections can be made. A more complex setup can be set by using the advanced 
version as follows.

Advanced mode:
 

To set how fast the individual samples are taken for the averaging calculation, select Period to enter a sampling period 
equal to one second or greater; or the Rate button for periods less than one second. If a sub-second sampling speed is 
to be used, select the required rate from the Rate drop down list. To set the length of time of the averaging, enter the 
value in the Duration spin box.

To set how often the average reading is calculated, enter the value in the Interval spin box.

In the example above, 1 minute of 2 Hz (2 times a second) readings are taken and averaged, with the cycle repeating 
every 5 minutes and the average values are reported every 5 minutes.

9.5 Bursting
All loggers support the ability to sample in a burst mode.
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To set up a logger to burst at sub-second rates (Hz) or with periods one second or greater, click Configuration tab 
> Sampling section, and then select Burst in the Mode drop down menu.  

There are two versions of the Burst Sampling section that can be used, either simple or advanced. This option can be 
set in Preferences.

Simple form:

In the simple form only predefined selections can be made. A more complex setup can be set by using the advanced 
version as follows.

Advanced mode:

To set how fast the individual samples are taken in the burst, select Period to enter a sampling period equal to one 
second or greater;  or the Rate button for periods less than one second. If a sub-second sampling speed is to be used, 
select the required rate from the Rate drop down list. To set the length of the burst in samples, enter the value in the 
Duration spin box.

To set the interval between burst measurements, enter the value in the Interval spin box.   

http://docs.rbr-global.com/display/RSKDOC/.Preferences+v5
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9.6 Tides and Waves

9.6.1 Tides 
Tide loggers use averaging to remove wave data from the pressure measurements, and the method for setting up the 
logger is the same as described for Averaging.

In the Sampling section of the Configuration tab, the tide parameters can be configured:

There are two versions of the Tide Sampling section that can be used, either simple or advanced. This option can be 
set in Preferences.

 Simple form:

 Advanced form:
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9.6.2 Waves
A |wave logger records wave and tide information, and the configuration is different from other loggers. For additional 
information on planning a wave deployment, please refer to |wave deployment planning.

If your logger is already logging data when you decide to change the configuration, you must stop logging, make your 
changes, and then start logging again. However, any data stored so far on the logger will be lost.

In the Sampling section of the Configuration tab, the wave parameters can be configured:

There are two versions of the Wave Sampling section that can be used, either simple or advanced. This option can be 
set in Preferences.

Simple form:

• In Speed, specify how fast you want pressure readings to be taken. In the simple form, you can select 
from the options in the drop-down list. In the advanced form, you can either set the period in 
multiples of seconds, or you can set a sub-second rate.

• In Duration (samples), select the number of samples that you want to take during a wave burst. The 
range is between 512 and 32768 samples.

• In Interval, enter the interval between the bursts. 
• In Instrument altitude (m), enter the number of meters above the sea or river bed where the logger 

will be secured in place. This value is used when making wave parameter calculations.
• In Mean depth of water (m), enter the total expected depth of the water where the logger will be 

deployed. This value is used to calculate the range of wave frequencies that can be measured, and 
those values will be displayed, in both bandwidth and period. Ruskin will calculate the actual depth 
from the measured pressure data post-deployment.

To configure advanced settings for wave sampling, go to Options menu > Preferences, and select General. On the 
General page, select the Enable advanced sampling controls check box under Sampling control – make sure to click 
OK.

Advanced form - sampling at one second or slower:

You can preserve the data by downloading it to a file before you restart the logger.

All |wave loggers automatically calculate tide data by averaging the wave burst data. There is no setup 
required to determine tide information with the wave logger. 


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Advanced form - sampling at 2, 4, 8, and 16 Hz

• In Speed, specify how fast you want pressure readings to be taken. In the simple form, you can 
select from the options in the drop-down list. In the advanced form, you can either set the 
period in multiples of seconds, or you can set a sub-second rate, depending on the check box 
selection.

• In Duration (samples), select the number of samples that you want to take during a wave 
burst. The range is between 512 and 32768 samples.

• In Interval, enter the interval between the bursts. 
• In Instrument altitude (m), enter the number of meters above the sea or river bed where the 

logger will be secured in place. This value is used when making wave parameter calculations.
• In Mean depth of water (m), enter the total expected depth of the water where the logger will 

be deployed. This value is used to calculate the range of wave frequencies that can be 
measured, and those values will be displayed, in both bandwidth and period. Ruskin will 
calculate the actual depth from the measured pressure data post-deployment.

9.6.3 |wave deployment planning
The following provides a guideline to establish a coherent deployment for |wave loggers.

The |wave logger should be fixed to a suitable support below the surface of the water, such as a dock or other rigid 
mooring. The logger must not be able to move in the water. The figure below offers a view of the logger fixed to a dock 
with a definition of the different water heights.

The timestamp of the burst for both a Tide and Wave datasets is the beginning of the burst.
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• Mean depth of water: an estimate of the average water depth, used for the initial prediction of 
expected wave frequencies that can be detected. Ruskin will use the actual depth measured by the 
logger for its calculations.

• Instrument altitude: The actual height of the logger above the seabed. This is defined by the 
deployment, and the logger must be physically affixed at this height during the installation. 

Given the height of the logger above seabed and the depth of logger as measured during the deployment, the total 
depth of water can be calculated.

Figure 1. Logger positioning

|wave logger positioning
For deployment planning, refer to Figure 1. Ruskin needs to know the expected mean depth of water (in metres) and 
the expected altitude (height) of the logger above the seabed to provide an estimate of the frequencies and periods of 
the wave that the logger is be able to measure. The logger measures water depth/pressure by means of a pressure 
transducer. The physics of what a pressure transducer can 'see' at depth depends on the height of water above the 
transducer as well as the amount of water below the transducer. High frequencies attenuate very quickly with depth. 
Figure 2 shows the attenuation with depth as a function of wave period in seconds (period = 1/frequency). This graph 
demonstrates that the placement of the logger is critical in determining frequencies/periods of the wave data to be 
captured by the logger. The pressure transducer may be placed in any orientation.   

 The basic rule is to place the logger as close to the surface of the water without the possibility that the logger 
will emerge from the water either because of large waves or low tides.
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Figure 2. Wave attenuation as a function of depth for various wave periods. 

This step in the deployment configuration requires that the 'expected mean depth of water', that is the total depth of 
water known from experience with the measurement site, and the 'expected altitude of the logger above seabed', a 
definition to be given to the diver, be entered. Note that on data retrieval the second value will be added to the 
measured depth of water above the logger when performing all wave calculations. 
When waves are enabled, the logger takes multiple pressure readings in a burst which allows for the reconstruction of 
the surface wave time series. There are three parameters which define the wave data:

1. Measurement speed: this defines the sampling rate or period for individual pressure readings used.
a. The rate possibilities are 2Hz, 4Hz, 8Hz, and 16Hz
b. The sampling rate defines several elements of the data capture:

i. The highest possible frequency visible in the data is limited to ½ the sampling frequency. 
However, this mathematical limit can not usually be achieved because of the attenuation 
characteristics shown above. 

ii. The sampling frequency defines the resolution of the frequency spectrum which can be 
calculated from the wave data. 

iii. The sampling frequency, together with the burst length, define the lowest frequency 
which can be assessed in a wave burst.

2. Wave measurement period: this defines how often wave bursts are collected.

3. Burst Length: this defines the number of samples in a wave burst. It must be a power of 2 and is 
chosen from the list: 512, 1024, 2048, 4096, 8192, 16384, and 32768. The longest wave period to be 
assessed is defined by: burst length/sampling frequency

The wave parameters work together to define the range of wave information which can be calculated as well as the 
memory and battery usage. 
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9.7 Gate Condition
Gating is a method to enable the logger based on a condition that may not be time based. The logger can be made to 
start and stop sampling based either on the conductivity sensor measurement (Marine wet switch) or by a mechanical 
activation (twist activation).

The Marine wet switch turns on the sensors to check the value of the conductivity sensor every 15 seconds. If the value 
exceeds 1 mS/cm2 logging will start until the conductivity values decrease below this threshold. 

For more information about how the twist activation works, see Twist Activation.

If the gating option is available on your logger select the appropriate option from the drop down menu. To enable the 
logger based on contact with water, select Marine wet switch. To enable the logger by twist activation select Twist 
activation. If the logger is to be enabled based on a specific start time, which is set in the Configuration tab, select
None. 

9.7.1 Twist Activation
If this option is available and selected, the logger starts or stops sampling based on the action of closing or opening the 
battery end cap. 

Marine wet switch
The threshold value for this setting may not be suitable for freshwater applications as many freshwater 
sources would not exceed 1 mS/cm2.


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When this option is selected, the logger starts to sample based on the Twist ON/OFF position rather than a schedule. To 
start sampling first click enable logging, the logger status will then become "paused" until the battery end cap is closed 
to the ON position. To pause the sampling, turn the battery end cap to the OFF position. The logger will vibrate to 
indicate if it is sampling or paused. A long vibration indicates that the logger is sampling and three short vibrations 
indicate that the logger is paused. 

9.8 Fetching and streaming data
The logger is capable of fetching measurements from the logger when connected over USB from the internal port, or, if 
an external connector is available, over USB or RS-232/485.

If you are still connected to the logger via USB, you can click Fetching in the Plot view toolbar. A graphical display 
appears of the samples fetched from the logger at the default speed for the logger type rather than of the samples that 
are scheduled and being stored on the logger.

Steps

1. Under the Options section of the Configuration tab, select Serial from the Realtime drop down 
menu. 

2. If you have an RS-232 interface, select RS232 from the Mode drop down menu. If you have an 
underwater USB interface or RS485, select USB or RS485 from the Realtime drop down menu. 

3. For an RS-232 or RS485 connection, select a connection speed from the Serial drop down list.  

If you have an underwater RS-232 interface, select Serial from the Realtime drop down menu and RS232 from 
the Mode drop down menu.


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If you are interfacing to an external system that requires a control signal input, such as a modem with a DTR input, you 
will need to configure the parameters for the auxiliary output control signal from the datalogger.

After the logger setup is complete and the schedule is enabled, the logger will automatically output as sample reading 
at the set sampling rate.

9.9 Mobile settings
If you have a mobile device, you can use it to configure, download, and view data from a WiFi-capable data logger. The 
Ruskin app is available on the Apple App Store and Google Play Store.

If you intend to use the Ruskin app you are advised to enable EasyParse (mobile) compatible data storage on the 
logger. Do not enable it for non-WiFi capable loggers. For additional information about the WiFi module, see WiFi 
module.

With EasyParse (mobile) compatible data storage selected, the logger data is parsed differently so that the download is 
faster over WiFi and a feature called cast detection is activated. The cast detection feature separates each 
profile into groups of down and up casts to make viewing of the profiles easier on the mobile device. 

To enable compatible storage for mobile devices in Ruskin, connect the data logger to a computer running Ruskin (not 
a mobile device) and go to the Options section of the Configuration tab and select Mobile from the Storage drop 
down menu.

 

9.10 Autoranging and fixed gain

Certain sensors, specifically turbidity and fluorometer sensors are capable of autoranging. The logger can change the 
gain setting on the front-end amplifiers in order to select the most appropriate range based on the environment being 
measured. The logger can also set the gain on the sensor to a fixed value selected by the user, rather than allowing the 
logger to select the gain as it measures.

Steps

1. Under the Ranging sensors section of the Configuration tab.
2. Any sensors present capable of autoranging are shown in Sensor. Select the sensor you want to 

configure from the list provided. 
3. Select the required gain value from the available selections in Range.
4. Repeat the above steps for the next available autoranging sensor.

Fixed gain:
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Autoranging (Automatic gain setting):

Range change events are displayed in the Plot view when the Display diagnostic is selected from the Events button, 

, located in the Plot view toolbar. Range change events are displayed as RANGE XX Units where XX indicates the 
current range and units are the units of the sensor – typically NTU for turbidity sensors and μg/l for fluorometers. For |
fast sampling where the change may be occurring over a number of samples the event is displayed as RANGE CHG and 
is followed by the final range event.

9.11 Voltage channel parameters
In the Voltage sensors section of the  Configuration tab, you can set the sensor parameters for the sensor attached to 
the voltage channel. Select the appropriate voltage channel and enter the sensor latency and the sampling current. 
These parameters are used in the deployment time calculation (battery use) and for determining minimal sampling 
intervals. 

 

 

9.12 Derived channel parameters
When configuring your logger, you can change the default values of parameters that are used to calculate derived 
channels.  These values are stored in the logger itself and are used in place of the values in Options menu > 
Preferences > Derived channels.

In the Parameters tab, you can configure the parameters to calculate derived channels on a logger that supports 
derived channels.  

You must enter these parameters for sensors not supplied by RBR.
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9.13 Deployment

Once you have ensured that the batteries are fresh, inspected the O-rings and programmed the logger (see Configure a 
logger), the instrument is ready to be deployed.

There are three precautions you should take to avoid damaging the logger and maximize the deployment autonomy:

1. Pay attention to the maximum pressure rating. All loggers with pressure sensors are individually rated 
to a maximum depth/pressure. This is indicated by the label which is placed on the logger's sensor 
end cap. Loggers which do not have a pressure sensor do not have this label, but are limited by the 
maximum depth/pressure rating of either the logger housing itself or of the sensors.

2. Avoid physical stress to the logger. Any type of clamp or bracket which concentrates the stress to the 
logger body is not recommended for use in logger mooring, mounting, and/or other deployment. 
Stress due to improper mounting may cause the logger to leak, resulting in the loss of valuable data or 
permanent damage to the electronics. RBR can provide proper mooring and mounting clamps suited 
to your specific application.

3. Use desiccant. If the logger is closed up in a warmer environment than the deployment environment, 
internal condensation can result. Since condensation may cause the circuitry to malfunction, the 
installation of desiccant prior to deployment is strongly advised.

9.14 Automatic Tasks
When working with a large number of similar instruments, Ruskin offers various automatic tasks, which can be toggled 
on and off from the Instruments menu, or by right-clicking the "Instruments" group in the navigator view.  Icons 
indicating the current state will be displayed on the "Instruments" group.  Since these tasks can change the state of the 
logger, the on/off state defaults to off each time Ruskin is run.
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Figure 1.  Instruments menu showing automatic tasks options.  If a task is enabled, it will show a check mark.

Figure 2.  Right-clicking on the "Instruments" group of the navigator view will show the automatic tasks.  If a task is 
enabled, it will show a check mark.

Figure 3.  "Instruments" group of the navigator view with icons indicating that auto-download and auto-deploy are 
enabled.

9.14.1 Auto-Download
When an instrument is detected, it will automatically start a download process and store the file using the common 
logger download naming scheme (serial number, date and time of download) in the last "save to" directory chosen.  
Other than possibly creating unwanted files, this option is safe since it does not alter the state of the logger.

9.14.2 Auto-Stop
When an instrument is detected, it will automatically stop the instrument if the instrument was previously enabled.  If 
auto-download is not also selected, a warning will be displayed about downloading the instrument data.  It is not 
possible to re-enable the instrument without erasing the instrument's memory, so it is advised to also use the auto-
download feature at the same time, or ensure that the data is downloaded prior to re-enabling the instrument.

9.14.3 Auto-Deploy
When an instrument is detected, the instrument will be stopped and then reprogrammed with the last known 
configuration settings.  It is highly recommended to also use auto-download with this setting since the instrument 
memory will be erased during the deployment set up.  To use this feature, first connect an instrument that will act as 
the model and configure that instrument with the desired settings and then turn on auto-deploy.  Each instrument 
connected, if it supports the same capabilities of the model instrument, will be configured to match the scheduling of 
the model instrument.  Auto-deploy implies auto-stop since the instrument must be stopped to update it with the new 
schedule information.
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10 Download

10.1 Download data from the logger
You can download data from a logger at any time. If you stop running a schedule, you must download the data before 
you restart the schedule to prevent the data stored so far from being lost. It is not possible to start logging without 
erasing the memory contents.

Steps

1. From the Configuration tab select Download. 
The Save as RSK dialog box appears.

2. Specify a location and a name for the data file. 
By default, the RSK file name uses the Ruskin file naming convention. For more information about the 
naming convention, see File naming convention below. 

3. The name of the new dataset appears and is highlighted automatically in Navigator view > Datasets. 
The Properties view changes to the new dataset and contains the following 
tabs: Analysis, Overview, Channels, and File Info. All the data that was stored on the logger at the 
time of the download is automatically plotted in the Plot view.

10.2 File naming convention
In Ruskin, by default, the name of a data file is composed of the following information:

• The first six digits represent the logger serial number.
• The next eight digits represent the current year, month, and day.
• The next four digits represent the current time to the minute.
• The file extension indicates the file format and should not be changed. If you change it, the file 

extension that you specify becomes part of the name, and the required extension is appended.

For example, the file named 911936_20090522_1613.rsk contains data for a logger with a serial number of 911936 
whose data was downloaded in 2009 on May 22 at 4:13 pm.

Downloading data again while the same schedule continues to run, picks up the same data plus any data 
stored since the last download.
You can add a comment after downloading a dataset.


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11 Calibration tab
The Calibration tab displays the calibration coefficients for each parameter (sensor) present and the date and time of 
the last calibration. Selecting the sensor from the dropdown menu Parameter toggles between the calibrations for the 
different sensors on the unit.

You can request a calibration quote for your logger by selecting Request calibration quote and sending the 
information directly to RBR Ltd. In the Calibration tab, click Request calibration quote, and when the Request 
calibration dialog box appears, enter the appropriate information. Make sure to verify that all information is correct 
before sending the request. You can edit any of the coefficients and use Store calibration to save the new coefficients 
to the logger.  Use Revert calibration to recover to the original coefficients if you have not already selected Store 
calibration. 

Calibration coefficients are calculated for each sensor, and the coefficients are stored in the logger. Calibration 
certificates are provided for each sensor and contain both the calibration equation and the coefficients. Hard copies are 
provided with each shipment, and the documents are contained inside the shipping box. Please refer to the calibration 
certificates for the coefficients and residuals. RBR can replace lost or misplaced calibration certificates.
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12 Update firmware
Instrument firmware upgrades can be performed from within Ruskin without having to return the instrument to the 
factory. Ruskin automatically checks to see if a newer version of firmware is available and displays a message in the 
Information tab.

Click the Update firmware button to upgrade the logger firmware. The following screen will appear:

Do not disconnect the logger until the process is fully completed. Disconnecting the logger during this process 
may render the logger inoperable.


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If for some reason RBR needs to supply a version of firmware, the following method is used to manually update the 
logger firmware.

Click the Instruments menu > Update logger firmware. 

Steps

1. In the Instruments menu, click Update logger firmware. 
The Update logger firmware dialog box will appear. 

2. Click the instrument drop down to select the instrument you wish to upgrade.
a. A default firmware image will be selected for your instrument. 
b. If RBR supplied a firmware file click the Select file button and browse to the location of the 

firmware update file provided. The file will have the extension .rbrfw.
3. Click Proceed to start the firmware upgrade. 

A progress bar shows the status of the upgrade. Once the firmware upgrade is complete, the message 
Update completed successfully appears at the top of the dialog box.

4. If the upgrade doesn't complete successfully, click Proceed again to retry until successful. 

5. Click Close.

Contact RBR for instructions before proceeding. This method of updating the firmware should only be 
attempted with the assistance of RBR.



Occasionally the logger will not reappear in the Navigator view following a successful upgrade. If this 
occurs, disconnect your logger from the USB port and then reconnect to re-establish communication.


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13 Datasets

13.1 Open a stored dataset
You can open any stored dataset to explore its contents.

Steps

1. Click File menu > Open dataset. 
2. Double-click the .rsk file that contains the data that you want to view. 
3. The name of the dataset appears and is highlighted automatically in the Navigator view. The 

Properties view changes to the dataset. The data in the file is automatically plotted in the Plot view.

13.2 Analysis

13.2.1 Analysis tab
The Analysis tab contains information and settings for configuring the calibration information and to display statistical 
information. You must already have an open dataset to view and configure these settings. For information about how 
to open a dataset, see Download.

Cursor tab
When a file is selected and plotted, the Analysis tab can be selected to display information about the dataset channels 
and their values.

To close a dataset, right-click its name in the Navigator view and click Close dataset. Or use File > Close 
dataset



Ruskin performs an integrity check that is intended to make sure that older data files are compatible 
with newer versions of Ruskin software. This information is displayed in File info. If the file requires 
updating the message indicates the issue with the file, and how long an update will take.
RBR strongly recommends that all files that have issues be updated.


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This table reports the value at each sample number when selected in the plot referenced to the vertical black cursor.

The sample number and time of the sample are displayed.

Selecting Display statistics gives you the ability to determine the average value and standard deviation over a range of 
samples. Change the number of samples in the average by using the spin buttons. The grey bar that appears on the plot 
view is the range of the samples in the average.

Calibration tab
When a file is selected and plotted for re-calibration the Calibration tab can be selected to assist with calculating 
calibration coefficients, see User calibration .

13.3 Overview
When a file is selected and plotted the Overview tab can be selected to display general information about the dataset.
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This is also the form on which you can enter a comment for the dataset and then press Save comment to save it.

13.4 Channels
The Channels tab displays three additional tabs: Information, Calibration, and Parameters.

The Information tab displays the measured parameter, the sensor manufacturer and the range setting. The type of 
derived channels and how it is calculated is displayed in a separate table.

The Calibration tab displays the calibration coefficients for each sensor.

The Parameters tab displays the values of the parameters, default values if other required parameters are required 
and the method used to calculate the derived channels.

13.4.1 Information tab
The Information tab displays the measured parameters, the sensor manufacturer and the range setting (if applicable). 
It also shows any derived channels that are available, and a description of the methodology used in the calculation of 
that derived parameter.
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13.4.2 Calibration Tab
The Calibration tab displays the calibration coefficients and temperature correction coefficients (as applicable) for 
each channel (sensor) and the date and time of the last calibration.

You can edit any of the coefficients and use Store and recompute data to recalculate the dataset. Use Revert 
calibration to recover to the original coefficients if you have not already selected Store and recompute data. To 
recover the original calibration coefficients edit one of the values and click in another cell. The Use deployment 
calibrations check box then becomes active and unchecked. Check this checkbox to restore the coefficients used by 
the logger and then press Store and recompute data to save the coefficients.

13.4.3 Parameters tab
When a file is selected and plotted, the Parameters tab can be selected to display the parameters used to calculate any 
applicable derived channels.

T-string
Thermistor strings have channel 1 referring to the node at the end of the string and the last channel being the 
node closest to the connector.


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The tab reports the relevant derived channel information for the sensors on the logger. The parameters can be edited 
to change the derived channel calculation. Once a parameter is modified, the Update and recompute and Revert 
settings buttons become active.

Revert settings rereads the RSK file and populates the form with the parameters from the file. Update and 
recompute writes the new parameters to RSK file and re-displays newly calculated data.

The following example is for a  CTD and dissolved oxygen logger where you can change the calculation parameters to 
calculate the derived channels:

 

Selecting the Seawater derivation in the Parameters tab results in a depth calculation based on UNESCO Technical 
paper 44.

The depth derivation equations can be found under the menu item Options menu > Preferences > Derived 
Channels > Depth tab. 

For |wave loggers you can change the wave calculation by adjusting how the depth is calculated and by adjusting the 
instrument altitude.

13.5 File info
When a file is selected and plotted the File info tab can be selected to display information about the file.
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If the message A new version of the RSK file format is available. appears, click Update. The update process may take 
some time, however, Ruskin does estimate the time with the message The anticipated update duration is <time 
period>. 

13.6 Plot view
You can use the Plot view to view a graphical display of data in datasets or live data. When viewing live data, the logger 
must still be attached.

A toolbar at the top of the Plot view contains various buttons to help you customise, explore, and export the graphical 
display.

Each channel appears as a different colour in the graphical display. These colours are specified for all graphical displays 
in Options menu > Preferences > Plotting and can be changed only there. You can also change other defaults affecting 
the Plot view in Preferences. For information, see Specifying plotting preferences

You can click a particular time (location) in the plot to view each channel value and related statistics at that time. A 
"double lollipop" vertical black line marks the place. The Cursor tab panel above (or on the side of the plot for live 
data) displays the channel values, units, the sample number, and the time that the data was measured.

For datasets only, you can select the Display statistics check box to view the average value and standard deviation for 
each channel based on the number of samples that you specify. 

If you want to copy the data to the clipboard and then paste it into another application, select a row, a column, a cell or 
click on the word channel for the entire table and then click Copy. 

The graphical display for each dataset appears on its own tab in the Plot view. The dataset file name appears at the top 
of the tab.

13.6.1 Thumbnail view
A downsampled representation of the dataset appears in a thumbnail view, along with an indicator of the current 
plotted time range.  The indicator can be positioned on the thumbnail view by clicking on the thumbnail view or 
dragging the indicator.  The indicator can be resized by dragging the edges, which will zoom the plot along the time 
domain to match the new indicator size.  The thumbnail always shows time-domain data, even if the plot is switched to 
depth-domain mode.

There are two formats of RSK file: full and EP. EP stands for Easy Parse (mobile compatible format that is 
typically used with WiFi enabled loggers). Only EP format files can be displayed on a mobile device. EP format 
files have calibration coefficients that cannot be edited, hence you cannot recalculate EP format files.



Files created by older versions of Ruskin must be updated to ensure compatibility. Failing to do so may result 
in odd graphical display and incorrect reporting of the sample values.



Scaling of the data is based on the on the minimum and maximum value sampled for each channel - 
sometimes there are erroneously high or low values that may make the real data appear incorrect. Use the 

vertical zoom   to increase the scale of the data displayed.


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13.6.2 Live data
You can use the Plot view to view a graphical display of logger sampling.  The data can come from one of two sources: 
fetching or streaming.  Fetching can be used on a logger that is either not enabled, or enabled without a streaming 
option.  Streaming can be used on a logger that has been enabled.  If fetching is used on a logger with streaming 
selected and the logger is enabled, the current file used for the fetching data will be closed and a new file started for the 
streaming data; fetching will be disabled.

The graphical display for live data for each logger appears on its own tab in the Plot view. The logger model and serial 
number appear at the top of the tab.

13.6.3 Plot Tools

Dataset toolbar

Live plot toolbar
The live plot toolbar appears to the right of the dataset toolbar.

Live data collection support in Ruskin is intended for debugging, development, and schedule trial purposes 
only and is not intended as a robust data collection solution.  Performance will degrade significantly if large 
(>50-100K samples, depending on hardware) data collections are performed, especially if there are a large 
number of events being reported.


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Tools for datasets and live data

Button Purpose Use

Filter Changes the type of annotation for the navigation 
buttons

• If an annotation is selected, switching filters zooms the 
view to the newly selected annotation.

• If no annotation is selected and switching filter from one 
profiling annotation type to another (profile, upcast, 
downcast), the view does not change.

• If no annotation is selected and switching filter between 
categories (profile, upcast, downcast to any other non-
profiling annotation type, or any non-profiling annotation 
type to any other annotation type), the view moves to the 
first annotation of the new category.

• Comment → Profile moves to first profile
• Profile → Comment moves to first comment
• Comment → Downcast moves to first downcast
• Profile → Downcast does not move.

Move to first, 
previous, 
next, and last

Move to the first, previous, next, and last annotation of 
the filter type

If annotation is selected also moves selection

Index The current annotation index, which can be edited.

If the currently selected annotation matches the time 
domain extent the text will appear blue, otherwise the 
text will be red

Click middle of index (the '/' ) to zoom to the annotation.
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Button Purpose Use

Create 
annotation

Select type of annotation to create.

After selection, click and drag left/right on main plot to 
create the annotation. When the click is released the 
annotation will be created as a temporary annotation, 
selected, and show its editable tooltip.

Profiles or geodata cannot overlap the same type - new 
annotations will fill the available space between existing 
profiles.

Cast 
detection

Runs a cast detection algorithm based on depth and 
conductivity to automatically generate profiles and casts

Event 
visibility

Turn on and off visibility of the various levels of events 
(error, warning, information, and diagnostic)

Zoom control Zoom in/out horizontally, vertically, and reset zoom to 
display the maximum extent of each axis

Zooming the range will center the data on the currently 
selected sample.

The annotation must be edited (such as adding a 
title or description, or, in the case of profiles, by 
adding an up or down cast) and saved (press 
ENTER/Return, or click the green check mark on 
the tooltip) before it will be saved in the RSK file.



Only available in time domain

Overwrites logger generated cast events and 
profiles


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Button Purpose Use

Auto-ranging Toggles the auto-ranging of the channel axes

Export plot Exports the current view of the main plot to pdf or png

Data 
rendering 
type

Choose lines, shapes, or lines and markers for the trace 
lines

Toggle 
channel 
visibility

Turn on or off channels to be visible in the plot view

Toggle on raw values removes the calibration equation 
from the sensor value

Plot by depth Toggles between plot by time and plot by depth

Disabling the auto-ranging of the axis can be 
useful for looking at trends in data



If no data appears in the Plot view, try changing 
the rendering to "Display Markers".  Time spans 
that are larger than expected will cause breaks 
between data points and lines will not be drawn 
connecting those points, whereas markers draw 
at each individual point.



If there is no depth channel the plot would then 
use the next pressure or pressure derived channel 
starting from the bottom of the channel list


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Tools for live data

Button Purpose How to use

 
Toggle the side 
data panel

The side data panel appears beside the charts and shows the 
file location that will be used to capture samples, the number 
of samples collected, the values of the last received sample, 
and the currently selected sample.  The side panel can be 
toggled on and off with this button.

Live plot time 
range 
selection

Click the button to display a drop down list of time span 
options to display the data by time period. For example, 
display 2 minutes of data. You can also choose to display all 
of the data collected.

Start or pause 
fetching

The logger supports either streaming or fetching data. 
Fetching is the action of asking the logger to take a reading 
and report it. Ruskin displays the fetched data every 1-2 
seconds. Fetching is disabled if the logger is enabled and has 
streaming turned on.

13.6.4 Shortcuts / Controls
• Data cursor:

• Click on the main plot to set the data cursor (double lollipop indicator).
• Move to the previous/next data sample: Left/Right Arrow Key

• To move by hundreds of samples, use Shift - Arrow
• To move by ten thousands of samples, use Alt - Arrow
• To move by millions of samples, use Shift - Alt - Arrow

• Annotations
• Double click on an annotation bar to zoom in to the range of the annotation.
• Click and drag on the edge of an annotation bar to resize the annotation, if the annotation is 

resizeable (CELL GPS annotations are not).
• Click and drag on the annotation bar to move the annotation, if the annotation is moveable 

(CELL GPS annotations are not).
• Main Plot

• Double click on the plot to reset to fully zoomed out.
• Shift-click and drag on the plot to select a zoom region.  The zoom region will be denoted by a 

rectangle.  Make sure to press shift before clicking.
• Control-click and drag on the plot to pan the plot.  Make sure to press control before clicking.
• Mouse wheel will zoom the plot in/out based on the current mouse position.

• Main Plot Axes
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• Double-click on an axis to set the axis to auto-range (show the full range of data).
• Click and drag an axis to pan the axis.
• Shift-click and drag an axis to zoom the axis in or out.
• Mouse wheel will zoom the axis in/out based on the current mouse position.

• Thumbnail
• To resize the viewable range, click and drag on the handles (gray bars) on or use the mouse 

wheel within the viewable range indicator.
• Click and drag the viewable range indicator to pan
• Click on a region not covered by the viewable range indicator to center the viewable range at 

that location.

13.7 Exporting datasets
You may want to share your data with others or analyse your data using other software. You can export data as a text 
file, which can then be imported into many applications, or export it in a particular format for analysis such as Microsoft 
Excel or OceanDataView.

You must already have downloaded the data to a dataset or opened an existing dataset.

Steps

1. Right-click the dataset whose data you want to export, and hover to Export as to open a submenu, or 
use File menu > Export dataset.

2. Select the appropriate export format (Excel, Text, OceanDataView or Bin). The exports found under 
the Legacy formats are not appropriate for newer instruments and so are not discussed here.

3. Specify a location and a name for the data file. 
4. Click Save.

Exports to Matlab may fail if the RSK file size exceeds 20MB. Alternatively, an RSK file can be imported 
directly into Matlab with our toolkit RSKtools that is available for download from our website at 
www.rbr-global.com. The RSK file is a single file database based on SQLite that allows us to have very 
large files with high-speed access to any part of the dataset.



Large files may not export completely into any of these formats. Large files should be converted 
to .txt and processed after the fact. The legacy Excel export is limited to 65000 rows



http://rbr-global.com/support/matlab-tools
http://www.rbr-global.com/support/matlab-tools
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14 User calibration
 Calibration coefficients are calculated for each sensor and the coefficients are stored in the logger. Calibration 
certificates are provided for each sensor and contain both the calibration equation and the coefficients. Hard copies are 
provided with each shipment and the documents are contained inside the shipping box. Please refer to the calibration 
certificates for the coefficients and residuals. RBR can replace lost or misplaced calibration certificates. 

Change calibration coefficients
Sensors such as dissolved oxygen, turbidity and pH that can be field calibrated will require you to update the 
calibration coefficients for these channels periodically. You may also need on occasion to manually enter new 
coefficients, although this is not recommended for factory calibrated sensors (for example C, T or D) unless instructed 
by RBR.

Steps

You can view static information about an instrument at any time as follows:

1. In the Navigator view, under the Instruments list, click the appropriate logger.
2. Click Analysis tab > Calibration tab to show the current calibration coefficients.
3. To manually change a coefficient, click on the appropriate entry in the table (C1, C2, C3, etc.). The 

current entry will be highlighted, and the new value can be typed.
4. If a two point calibration has been performed, and calculated coefficients have been copied, right 

click on either the Time or Parameter entry for the parameter you wish to modify. Select Paste to 
selected row from the drop down menu.

5. Click Store calibration to write the calibration coefficients to the logger.
6. If you need to revert to previous coefficients, click Revert calibration.

14.1 N-Point calibration
Sensors such as pH, Dissolved Oxygen (Oxyguard or Rinko) or turbidity generate a voltage output that is proportional to 
the value of the parameter being measured. To calibrate these sensors, Ruskin offers an N-point calibration method to 
generate calibration coefficients.

14.2 Oxyguard DO calibration

Equipment

If you do not click Store calibration, the coefficients will not be written to the instrument, and will be lost 
once your session is closed. 



The Oxyguard DO sensor has a true zero point and therefore it can be calibrated using the single-point 
calibration method using a reading at 100% oxygen concentration only. The 100% calibration should be 
performed at the expected temperature and salinity of the deployment environment.
If the logger has a pH/ORP sensor and Oxyguard DO sensor, it is advisable to ensure that the pH/ORP and 
Reference sensors are submerged in the water during measurement.


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1. Two Large mouth beakers
2. Sodium sulphite Na2SO3
3. Aquarium air pump
4. Magnetic stirrer

Preparing solutions

 Reference Point 1 solution – Oxygen saturated solution at expected temperature and salinity of deployment 
environment

1. Fill the large beaker with 2 L of water. And install magnetic stirrer.
2. Bubble air through the water using an air pump (an aquarium air pump would work).  
3. Switch ON the air-pump and the magnetic stirrer.

Reference Point 2 solution – Dissolved oxygen concentration of zero

1. In a beaker, dissolve approximately 5 tsp of sodium sulfite (Na2SO3) into 500 mL tap water.  
2. Mix the solution thoroughly with a magnetic mixer. The solution will be oxygen-free after 15 minutes. 

Steps

1. In Ruskin, configure the instrument to sample at a fast rate, between 6 Hz and 3 seconds. 
2. Use Sync to PC to ensure the logger clock is synchronized to the PC clock, and ensure the end time is 

set so that the logger will keep sampling until calibration is complete.
3. Submerge the dissolved oxygen sensor in the Reference Point 1 solution for at least 15 minutes near 

the stirrer so that it is in the best mixed area of the bath.
4. Take sample readings for at least 15 minutes for the 100% calibration point, making note of the time 

that the sample is being measured.
5. Submerge the dissolved oxygen sensor in the Reference Point 2 solution for at least 15 minutes for the 

0% calibration point, making note of the time that the sample is being measured.
6. Retrieve the data from the data logger as per the steps in Download.
7. The calibration data should now be displayed in the Plot view. In the Properties view, go to Analysis

tab > Calibration tab.
8. Select the dissolved oxygen sensor type from the drop down list. 
9. The Number of Samples spinner box is automatically set to 100. 

This value is the number of sample points Ruskin will average the calibration coefficients for the 
sensor. Typically, this value should be in the range of 50 to 100 samples.

10. Click on a stable point in the Plot view corresponding to 100% oxygen. In the table in the first row, 
under Real Avg, enter 100 and press enter. 

11. Select the check box in the second row in the table, then click on a stable point in the Plot view 
corresponding to 0% oxygen. In the table in the second row, under Real Avg, enter 0 and press enter.

12. Ruskin automatically calculates the calibration coefficients, and these values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.

13. Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the 
data logger.
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14.3 Rinko optode calibration
The Rinko optode can be calibrated using Ruskin N-point calibration.

Equipment

1. Two Large mouth beakers
2. Sodium sulphite Na2SO3
3. Aquarium air pump
4. Magnetic stirrer

Preparing solutions
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 Reference Point 1 solution – Oxygen saturated solution at expected temperature and salinity of deployment 
environment 

1. Fill the large beaker with water 2 L, and install magnetic stirrer.
2. Bubble air through the water using an air pump (an aquarium air pump would work).  
3. Switch ON the air-pump and the magnetic stirrer.

 Reference Point 2 solution – Dissolved oxygen concentration of zero

•  In a beaker, dissolve approximately 5 tsp of sodium sulphite (Na2SO3) into 500 mL tap water. Mix the 
solution thoroughly with a magnetic mixer. The solution will be oxygen-free after 15 minutes. 

Steps

1. In Ruskin, configure the logger to sample at a fast rate, between 6 Hz and 3 seconds. 
2. Use Sync to PC to ensure the logger clock is synchronised to the PC clock, and ensure the end time is 

set so that the logger will keep sampling until calibration is complete.
3. Submerge the dissolved oxygen sensor in the Reference Point 1 solution for at least 15 minutes near 

the stirrer so that it is in the best mixed area of the bath.
4. Take sample readings for at least 15 minutes for the 100% calibration point, making note of the time 

that the sample is being measured.
5. Submerge the dissolved oxygen sensor in the Reference Point 2 solution for at least 15 minutes for the 

0% calibration point, making note of the time that the sample is being measured.
6. Retrieve the data from the data logger as per the steps in Download. 
7. The calibration data should now be displayed in the Plot view. In the Properties view, go to Analysis

tab > Calibration tab.
8. Select the dissolved oxygen sensor type from the drop down list. 
9. The Number of Samples spinner box is automatically set to 100. 

This value is the number of sample points Ruskin will average the calculate the calibration coefficients 
for the sensor. Typically, this value should be in the range of 50 to 100 samples.

10. Click on a stable point in the Plot view corresponding to 100% oxygen. In the table in the first row, 
under Real Avg, enter 100 and press enter. 

11. Select the check box in the second row in the table, then click on a stable point in the Plot view 
corresponding to 0% oxygen. In the table in the second row, under Real Avg, enter 0 and press enter.

12. Ruskin automatically calculates the calibration coefficients, and the values appear in Calibration 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.

13. Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the 
data logger.

  



RBR#0006105revE  –  68

14.4 Turbidity calibration
The Seapoint turbidity sensor is calibrated by RBR with a two-point calibration technique. We recommend to do a two 
point calibration performed under fluorescent lighting.

Alternatively, one can do a single point calibration. If doing a single "0" point calibration in disstilled water the 
calibration will only correct the coefficients for an offset.  If only a single non zero point is performed the callibration 
will recompute the slope coefficient. We recommend to only perform a "0" point calibration unless you are confident on 
your non zero standard.
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14.4.1 Two-point calibration
Equipment (entire logger submerged)

• 4000-FTU Formazin standard – 500 ml
• Distilled water – 5 L
• Black-walled, wide-mouth container (large enough to hold the logger)
• Volumetric flask 1000 ml, class A
• Volumetric flask  200 ml, class A
• Stir stick

Steps (preparing solutions)

1. In Ruskin, configure the data logger to sample using a 10 second sampling interval and set the sensor 
to autoranging - see Autoranging and fixed gain. 

2. Use Sync to PC to ensure the logger clock is synchronised to the PC clock, and ensure the end time is 
set so that the logger will keep sampling until calibration is complete.

3. Flush the sensor, container and glassware with distilled water and dry them.
4. Fill the black wall container with 5000 ml distilled water using the large volumetric flask.
5. Set the sensor in the container until the sensor is fully submerged in the distilled water. 

6. Record the data in distilled water for five minutes. 
This is the zero-turbidity calibration point.

7. Fill the 500 ml volumetric flask with Formazin Standard. Remember to gently shake the bottle before 
opening the Formazin solution.

8. Add 500 ml Formazin Standard to the black wall container with distilled water, and gently mix the 
solution with a stirring stick.

9. Calculate the value of the standard turbidity solution at calibration point according to following 
formula: 
 

10. After five minutes, remove the logger from the calibration container and wash the sensor head under 
regular tap water.

11. Retrieve the data from the data logger as per the steps in Download. 
12. The calibration data should now be displayed in the Plot view. In the Properties view, go to Analysis

tab > Calibration tab.
13. Select the Tu sensor type from the drop down list.  

If you plan to submerse only the sensor, you can decide on the container volume and adjust the solution 
volumes appropriately.



The distance from the sensor's windows to the container wall must be at least 20 cm. If possible, place 
a dark cover on the calibration container and avoid direct light on the container.



Calculating dilution
TuSTD = TuSTK*VTOT/(VDW+VTOT) = 363.63 FTU
Where:
TuSTD = turbidity of the standard solution (FTU)
TuSTK = 4000FTU – turbidity of the stock solution
VTOT = 500 ml volume of stock solution at calibration point (ml)
VDW = 5000 ml - initial volume of distilled water


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14. The Number of Samples field is automatically set to 100. 
This value is the number of sample points Ruskin will average calculate the calibration coefficients for 
the sensor. Typically, this value should be in the range of 50 to 100 samples.

15. Click on a stable point in the Plot view corresponding to 0 NTU. In the table in the first row, under
Real Avg, enter 0 and press enter. 

16. Select the check box in the second row in the table, then click on a stable point in the Plot view 
corresponding to reading of your turbidity solution. In the table in the second row, under Real Avg, 
enter the value of your turbidity solution and press enter.

17. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.

18. Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the 
data logger.

By using the above formula and changing the volume of distilled water and Formazin solution, you can 
prepare different calibration points or different volumes for checking linearity of the turbidity sensor or getting 
close to real turbidity value of standard turbidity solution.


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14.4.2 One-point calibration
Using the same procedure as in the 2-point calibration, one can use only the distilled water or formazin standard to 
generate new coefficients from a single point.

RBR suggests to use the one point calibration for establishing a new "0" value only, as unless one is very confident on 
their non zero point they may put the unit out of specification.

After you have generated a dataset of your single point as described in the procedure above follow the setps below:

1. Retrieve the data from the data logger as per the steps in Download. 
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2. The calibration data should now be displayed in the Plot view. In the Properties view, go 
to Analysis tab > Calibration tab.

3. Select the Tu sensor type from the drop down list.  
4. The Number of Samples field is automatically set to 100. 

This value is the number of sample points Ruskin will average calculate the calibration coefficients for 
the sensor. Typically, this value should be in the range of 50 to 100 samples.

5. Click on a stable point in the Plot view corresponding to 0 NTU. In the table in the first row, 
under Real Avg, enter 0 and press enter. 

6. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.

7. Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the 
data logger.
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14.5 Idronaut pH calibration
Calibration of the pH sensor should use two or more pH buffers, and should be carried out every day that the electrode 
is used for optimum accuracy. It is recommended that a pH 7 buffer be used to check the zero point and an acid and an 
alkaline buffer used to set the slope. RBR uses pH 4 and pH 10 to measure the slope.
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Steps

1. In Ruskin, configure the logger to sample at a fast rate, between 6 Hz and 3 seconds. 
2. Use Sync to PC to ensure the logger clock is synchronised to the PC clock, and ensure the end time is 

set so that the logger will keep sampling until calibration is complete.
3. Submerge the pH sensor in the pH 4 buffer solution for at least 15 minutes near the stirrer so that it is 

in the best mixed area of the bath. 

4. Submerge the pH sensor in the pH 7 buffer solution for at least 15 minutes near the stirrer so that it is 
in the best mixed area of the bath.

5. Submerge the pH sensor in the pH 10 buffer solution for at least 15 minutes near the stirrer so that it is 
in the best mixed area of the bath.

6. Retrieve the data from the data logger as per the steps in Download. 
7. The calibration data should now be displayed in the Plot view. In the Properties view, go to Analysis

tab > Calibration tab. 
8. Select the pH sensor type from the drop down list. 
9. The Number of Samples spinner box is automatically set to 100. 

This value is the number of sample points Ruskin will average the calibration coefficients for the 
sensor. Typically, this value should be in the range of 50 to 100 samples.

10. Click on a stable point in the Plot view corresponding to the pH 4. In the table in the first row, under 
Real Avg, enter 4 and press enter. 

11. Select the check box in the second row in the table, then click on a stable point in the Plot view 
corresponding to pH 7.  In the table in the second row, under Real Avg, enter 7 and press enter.

12. Select the check box in the third row in the table, then click on a stable point in the Plot view 
corresponding to pH 10.  In the table in the third row, under Real Avg, enter 10 and press enter.

13. Ruskin automatically calculates the calibration coefficients, and the values appear in Calculated 
coefficients. Clicking the Copy button saves the new calibration coefficients to the clipboard.

14. Follow the steps in Change calibration coefficients to update the coefficients for this sensor in the 
data logger.

Ensure that the pH sensor is rinsed with clean water between each sample reading to avoid 
contamination between buffer values.
Ensure that both the pH and Reference electrode are submerged in the same solution.
If the logger has a pH/ORP sensor and an Oxyguard DO sensor, it is advisable to ensure that the DO 
sensor is submerged in the buffer during measurement.


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15 Preferences
Ruskin sets global preferences that require no changes in many situations. However, as you learn more about what 
Ruskin can do, you may want to change some of these defaults to better suit your requirements. The global preferences 
include:

• where to store output files
• plotting preferences
• configuring derived channels
• calculating derived channels when sensors are missing

You can change these preferences at any time.

15.1 Specify location for data files
You can control where data files are stored by default. Specify these locations before downloading any data.

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.
3. In File location, type a directory name in the Directory for RSK files text box, or click Browse to 

locate the directory where you want to store data files. 
4. Click Apply or OK.

You can change where future data files are stored by default at any time. The change takes effect immediately.

15.2 Specify location for realtime data files
You can control where realtime files are stored by default. Specify these locations before connecting any instrument.

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.
3. In File location, type a directory name in the Directory for realtime RSK files text box, or click 

Browse to locate the directory where you want to store data files. 
4. Click Apply or OK.

You can change where future data files are stored by default at any time. The change takes effect immediately.

15.3 Specify location for log files
You can control where log files are stored by default. Specify these locations before downloading any data.

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.

Realtime files are generated when a connected instrument is streaming or when the user enables fetching 
mode on the instrument.


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3. In File location, type a directory name in the Directory for log files text box, or click Browse to locate 
the directory where you want to store log files. 

4. Click Apply or OK.

You can change where future log files are stored by default at any time. The change takes effect immediately.

15.4 Specify Language selection
Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.
3. In Language selection, select a language from the list. 
4. Click Apply or OK.

15.5 Using advanced sampling controls
 Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.
3. In Sampling control, select Enable advanced sampling controls check box to change from the 

simple control.
4. Click Apply or OK.

15.6 Using advanced calibration controls
 Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click General.
3. In Calibration control, select Enable advanced calibration controls check box to change from the 

simple control.
4. Click Apply or OK.

Log files are used when you request RBR support.

Simple control: provides a default list of fixed values.
Advanced control: provides the user the ability to enter any values.



Simple control: provides the user the ability to view and edit the main coefficients (C) for any channel.
Advanced control: provides the user the ability to view and edit all main and dependency calibration 
coefficients (C,X) for all channels.





RBR#0006105revE  –  78

15.7 Derived channel preferences

Derived channels contain calculated data based on data from measured channels. In the Derived Channels section of 
the Preferences dialog box, you can choose additional channels derived from measured channels. You can also set the 
salinity, pressure, and temperature values used to calculate the derived channels when a sensor is not available.

Derived channels are included by default in the Plot view and in datasets.

15.7.1 Add depth as a derived channel
If your logger has a pressure channel, you can use its measurements to derive a depth channel. The data calculated for 
this derived channel appears along with measured channels in the Plot view and in datasets.

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side of the Preferences dialog box, click Derived Channels.
3. On the Depth tab, select the Enable Depth Channel check box. 

For new loggers, all derived channels are calculated regardless of the check box status.
4. In the Atmospheric Pressure box, type a deciBar value for the atmospheric pressure on the logger or 

use the default value. This value corrects the pressure measurements during the depth calculation.
5. Click either Simplified calculation or Seawater calculation, which is a calculation based on a 

UNESCO technical paper:
a. If you want to use the simplified calculation, type the actual water density or use the default 

value. Note that for freshwater, the density should be set to 1.0.
b. If you want to use the UNESCO seawater calculation, specify the latitude of the data collection 

in degrees and minutes.

15.7.2 Add dissolved oxygen as a derived channel
You can derive a dissolved oxygen channel that measures the oxygen saturation as a percentage. The data calculated 
for this derived channel appears along with measured channels in the Plot view and in datasets.

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side of the Preferences dialog box, click Derived Channels.
3. Click the Dissolved O2 tab and select the Enable Dissolved Oxygen Channel check box. 

For new loggers, all derived channels are calculated regardless of the check box status.

The derived channels settings in Preferences was originally intended for XR(X),1060, 2050, and 1050 RBR data 
loggers. It does not apply to newer generations.
Newer generations calculate all the possible derived channels for that specific logger.
Use the Parameters tab to set up initial derived channel parameters.
For downloaded files, use data set Parameters tab.



If you suspect that the derived channel value is incorrect check to make sure that the no sensor present
values are correct. For example, if a Dissolved Oxygen saturation measurement is made in lake at 8 degrees 
but the no sensor present salinity value is 35 and temperature is 15 degrees the concentration reported will 
be incorrect. Adjust the no sensor present values and re-compute.


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4. If any of your loggers use the Oxyguard DO sensor to measure oxygen saturation and you want to use 
the Weiss equation, select the Calculate concentration using the Weiss equation check box and 
select the output unit, one of µMol/L, mg/L or mL/L.
The Weiss equation requires values for temperature and salinity. If your logger does not measure 
these things, you can specify standard values on the No sensor values tab.

5. If any of your loggers use the Aanderaa Optode DO sensor to measure oxygen concentration, select 
the Calculate concentration check box and select the output unit, either mg/l or ml/l.

6. If any of your loggers use the Aanderaa Optode DO sensor to measure oxygen saturation, select 
the Calculate saturation using the Garcia and Gordon equation check box.
The Garcia and Gordon equation requires values for temperature and salinity. If your logger does not 
measure these things, you can specify standard values on the No sensor values tab.

15.7.3 Calculate derived channels when sensors are missing
When your sensors do not provide the salinity, pressure, or temperature values needed to calculate derived channels, 
you can specify actual values to use instead.

Steps

1. From the Options menu, click Preferences.
2. In the list on the left side of the Preferences dialog box, click Derived Channels.
3. Click the No sensor values tab.
4. In the boxes provided, specify the values that you want to use when actual values are not provided by 

your sensors.

15.8 Specifying plotting preferences
You can specify how you want the graphical display in the Plot view to behave by default. With the exception of 
choosing colours for each channel, these preferences can be overridden for a particular graphical display in the Plot
view. 

15.8.1 Channel visibility tab
The Channel visibility tab displays many options to hide or show specific information in the Plot view. These settings 
are applied when displaying a dataset in the Plot view. Some information in this tab is enabled by default. When you 
select any of the check boxes in this tab, the action is immediate. 

Channel visibility tab with default settings

You can click Apply to save your changes without closing the dialog box.
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Steps

1. From the Options menu, click Preferences. 
2. In the list on the left side, click Plotting. 
3. On the Channel visibility tab, select the check box for the information you want hidden.  

Events appear at the x-axis as a vertical grey line with brief text to indicate the type of event, such as 
STP for a stop event in a dataset. Refer to Appendix C - Event and Error Stamps for a list of the event 
types. 

4. To hide all measured channels, select By default, hide all measured channels check box. 
5. To hide all derived channels, select By default, hide all derived channels check box. 
6. To show information, clear the check box beside the information you want shown. 

15.8.2 Channel colours tab
The Channel colours tab allows you to choose a different colour for each channel that is shown for information 
currently running in Plot view, or from an opened dataset. If there is no colour available that you like, you can create 
your own colour. When you select a colour, the new colour is immediately updated by Ruskin. 

Channel colours tab with the Colour dialog box to customize a colour for a channel
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Steps

1. From the Options menu, click Preferences.
2. In the list on the left side, click Plotting.
3. Click the Channel colours tab. 
4. In the channels listed, click the channel you want to change the colour for. 
5. Click the colour box that appears beside the channel list. 
6. With the colour dialog box open, select a colour from the Basic colour area. 
7. Select OK to apply the colour to the channel. 
8. To create a custom colour: 

a. Repeat steps 4 and 5.
b. Click Define Custom Colours and then choose a colour. 
c. Click Add to Custom Colours to add the new colour to Custom colours.
d. Click OK to apply the new custom colour to the channel. 



RBR#0006105revE  –  82

16 Logger Hardware

16.1 Opening and closing the logger
Loggers have two end caps: the sensor end cap houses the sensors, and the battery end cap covers the data port and 
battery cover plate. Access to the data port and the battery cover is gained by removing the end cap opposite the 
sensor end of the logger. It may be unscrewed by hand or by using a rod inserted into the mooring line hole for 
leverage. The end cap does not unscrew completely until the O-ring is clear of its mating surface in the body. This 
ensures that it will not eject at high speed should the interior of the logger become pressurised.
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Closing the logger is exactly the reverse of opening it. Remember to keep the O-rings clean and avoid scratching the O-
ring mating surfaces. Carefully inspect the O-rings, as described in the Inspecting the O-rings section, before deploying 
the logger. Do not use excessive force when tightening the end cap; hand-tight is quite sufficient, as the seal depends 
upon the O-rings, not the end cap tightness.

16.2 Changing the batteries
Loggers are powered by eight AA size cells. These can be almost any chemistry with only a few restrictions depending 
on the sensors ordered. Check your loggers compatibility in Ruskin to see if your instrument has a restriction. 

Steps

1. Remove the battery end cap from the logger.
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2. Using both thumbs, press down on the "+" symbols on the battery cover and slide in the direction of 
the arrow. The battery cover can then be folded up.

 
3. Invert the logger to allow the batteries to slide out of the battery carriage.
4. Insert fresh batteries into the battery carriage with the negative terminals pointing inwards, four (4) 

batteries per channel.
5. Close the battery cover by folding down and then pressing with both thumbs on the "+" symbols and 

sliding in the opposite direction of the arrow.
6. Replace the battery end cap.

16.3 Installing desiccant
The logger has a dedicated location for placement of desiccant in the battery end cap, which will accommodate three 
(3) Dricap desiccant capsules (part # 0003240 (qty9), or 0005668 (qty100)).

Steps

1. Remove the battery end cap from the logger - see Opening and closing the logger.
2. Inside the battery end cap, there are 3 recessed sockets. Insert a desiccant capsule into each socket, 

ensuring that each is securely placed.

3. Replace battery end cap.
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16.4 Twist activation option
Loggers purchased with this option can be enabled without a schedule by activating Twist Activation (see Gating 
Condition). You must first enable this mode and enable the logger. Closing the battery end cap enables the logger. 
When enabled by twist activation the logger will vibrate for a few seconds. To stop the logger, open the battery end cap 
one quarter turn. When the logger is stopped it will vibrate for a few seconds to provide positive feedback.

16.5 Wi-Fi module

The Wi-Fi module will be powered for 60 seconds whenever the battery end cap is turned to the on or off position 
regardless of whether logging has been enabled or not, allowing for connection to Ruskin, downloading data, and 
programming the deployment. See image below for an example use case:
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If you have a Wi-Fi-capable logger and a mobile device, you can connect and view data from the logger on the mobile 
device. The following explains how to set up your logger, connecting to the mobile device using Wi-Fi, and what 
information you can view from the mobile device. You must install the Ruskin app from the App store in order to view 
the logger's information. 

16.5.1 Setting up your logger
You must set up your data logger first, before connecting it to the mobile device. 

The Configuration tab contains the Enable, Revert settings and Use last setup buttons. When you click Enable, the 
logger setup parameters are stored to the logger and the schedule is enabled. When you click Revert settings, you 
automatically revert the logger configuration back to previous settings. 

Use last setup is intended for configuring multiple loggers using the same schedule. For example, to set up three |tide 
loggers with exactly the same parameters, set one logger up and enable it; connect the second and third logger and 
when you click Use last setup button, these two loggers will be set up with the exact same parameters as the first 
logger. 

Steps

1. Connect the logger to the computer and then open Ruskin.
2. In the Configuration tab's Sampling section, select Twist activation from the Gate drop down 

menu.
3. In the Configuration tab's Options section, select Mobile from the Storage drop down menu 

for EasyParse (mobile) compatible data storage.

You can connect to a Wi-Fi logger with Ruskin (not Ruskin App) on your computer by connecting to the logger 
Wi-Fi network. Ruskin will automatically detect the logger. Many of the details discussed below are applicable 
to communicating with you logger over Wi-Fi with Ruskin


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4. In the Configuration tab's Sampling section, set the sampling regime and measurement speed. 
See Schedule a logger.

5. Click Enable. 
6. Disconnect the logger from your computer.
7. Insert the Wi-Fi module. 
8. Close the battery end cap.

16.6 Maintenance and repairs

16.6.1 Instrument calibration
We recommend that you verify the calibration of your data logger before any critical deployment, periodically once a 
year, or if you suspect the calibration to be out of specifications. Discuss your calibration needs with RBR. In some 
cases, you will be recommended to return the instrument to RBR to have it checked and re-calibrated. Please contact 
us for our current calibration fees.

16.6.2 O-rings
The single most important item of maintenance on any RBR submersible data logger is care of the O-rings. Any kind of 
water leak can damage the circuitry beyond repair and cause complete data loss. Every logger's seal depends upon its 
O-rings, not the end cap tightness. Proper O-ring maintenance, therefore, is crucial.

If you don't want the logger to sample immediately turn the battery end cap to the Off position. See Twist 
Activation for more details.



O-rings may lose elasticity over time due to pressure, even when the logger is not deployed. We strongly 
suggest that the O-rings be replaced regularly, for example, before every deployment, or after a change of 
batteries, or at least once a year.


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Inspecting O-rings
Pay attention to the following areas:

• The surface of the O-ring itself
• The mating surface on the inside of the case between the threads and the open end
• The inner surfaces of the groove in the end cap where the O-ring sits

Any dirt present should be removed by wiping thoroughly with a soft, lint-free cloth. When cleaning, never use any 
material or tool which could scratch the O-ring or any of its mating surfaces. If any dirt is present in the O-ring groove, 
then the O-ring should be removed as described below to allow thorough cleaning of the groove. If an O-ring needs to 
be removed for any reason, it should be replaced.

If the O-ring is scratched, cut, distorted, perished or defective in any other way it must be replaced. If any of the surfaces 
of the O-ring groove are scratched, pitted or otherwise damaged, the logger may need to be returned to RBR for 
refurbishment: please contact us for advice.

Replacing an O-ring

1. Lever the O-ring from its groove. Use a soft plastic or wood tool; do not use a metal screwdriver or any 
other tool which may scratch the surfaces of the O-ring groove, doing so will probably render the end 
cap useless. Slide the O-ring out of its groove and off the logger. The O-ring may need to stretch quite 
a bit as it is pushed off; this requires some effort but can be done by hand.

2. Thoroughly clean the O-ring groove, taking great care not to scratch or damage it in any way. Inspect 
it carefully, and contact us for advice if it appears damaged. Apply a light film of silicone grease to all 
three inside surfaces of the groove, being careful not to trap any dirt, hairs or lint.
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3. Select the proper O-ring, see part numbers below, and make sure it is not damaged. Lubricate it with a 
very light film of silicone grease to ease its installation.

4. Install the new O-ring by pushing it into place and popping it into its groove.
5. When the new O-ring is in place, inspect it once more for scratches and dirt, and wipe away any 

silicone grease deposited on the end cap.

Most experienced users of oceanographic equipment replace all O-rings before every deployment as a matter or 
routine. The cost of an O-ring is negligible compared with the cost of the instrument and its deployment. Routine 
replacement of O-rings, therefore, is cheap insurance.

Plastic bodies: #2-225 N70 O-ring

Titanium bodies: #2-225 N70 O-ring, #8-225 N90 backup ring

16.6.3 Repairs
We support all instruments and software that we manufacture. First line support is always available by phone, fax or e-
mail. Please contact us immediately if you are experiencing problems with your RBR product.  It is very important to 
contact us before returning your instrument, as some difficulties can be easily solved on-site by the user. Please have 
the model and serial number of the unit handy when you contact us at support@rbr-global.com.

There are no user-repairable parts of the logger. Any attempt at repair, whether successful or not, without prior 
authorization from RBR Ltd. will void the warranty. If it is necessary to return the product to RBR for an upgrade, repair, 
or calibration; please review the detailed shipping information on our website www.rbr-global.com before returning 
the unit.

In the unlikely event of an instrument requiring service at RBR, contact us for an RMA number and please use the 
following shipping address:

RBR Ltd
95 Hines Road Unit 5
Kanata, Ontario
CANADA K2K 2M5

Telephone +1 (613) 599-8900

For those who are shipping from outside of Canada, you will need to clearly mark the waybill and any other customs 
paperwork with the following:

"Canadian goods being returned to manufacturer for repair. NOT A SALE."

Please state the instrument value on the waybill as closely as possible to the current market value based on the original 
purchase price less depreciation. Please contact RBR if you have any questions about the instrument value. Send the 
unit using your own preferred method (prepaid).  However, we suggest that you do not use Ground Service, since 
customs brokerage charges will be billed incorrectly.

Units repaired under warranty will be returned prepaid by RBR.  Warranty repairs are decided on a case by case basis. 

Standard Repair Charges (Non-warranty)

Our minimum repair charge is $150 CAD. This charge covers a comprehensive initial check, including verification 
calibration and sensor functionality. Minor repairs are also covered by this basic fee. If further repair work or re-
calibration is necessary, a quotation will be issued to the customer. Once we have received authorization to proceed, 
the repair shall be completed and the instrument returned as soon as possible. Please note that any units returned with 
low (or no) batteries will have new batteries installed and the costs will be added to the repair invoice.

mailto:support@rbr-global.com
http://rbr-global.com/support/service-and-repair
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16.6.4 Support kits
To simplify maintenance of your data logger, RBR sells support kits with enough O-rings, and silicone grease for 5 
deployments. Please contact RBR for more information or to place an order.

16.7 Internal and External Power draw
RBR loggers may be powered by an external source with a voltage range from 4.5-30V.

16.7.1 Order of power draw
When an external power supply is present, the logger will preferentially draw power from this source and not consume 
the internal batteries. For a logger that is powered by an external source, the internal batteries serve as backup power 
in the event the external source fails. 
The logger is powered by the external power source as long as the voltage is greater than 4.5V. If the external voltage 
drops below 4.5V, the system switches on the internal batteries.

16.7.2 Paused
Twisting the battery end cap toggles the logger between the "Play" and "Paused" states. When the instrument is in the 
"Paused" state the power draw is truly 0, so it is not necessary to stop the logger if it will remain in this state for an 
extended period of time.

16.7.3 USB Power
When connected, USB preferentially powers the logger during configuration or data download, however, if sampling 
occurs while connected via USB the internal batteries are used during the sample.
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17 Appendices

17.1 Appendix A - Event and Error Stamps

The following is a list of event/error stamps that may be displayed in the data set.

TIMESTAMP - Time synchronization event, is used to ensure timing synchronization, whenever there is a possibility that 
the actual date/time of a sample according to the logger's internal calendar/clock does not match what is expected in 
the normal sampling sequence.

USER STOP - Sampling stopped by user, is used to indicate that a command to stop sampling occurred.

UNKNOWN - An unknown error has occurred, is used to indicate that the error has occurred in the logger and the cause 
of the error is unknown.

ERROR ## - Change event (system restart where logger clock is no longer valid), is used to indicate an internal error has 
occurred in the logger.

RESTART ## - Warm startup event (clock and programmed parameters are valid/unharmed), indicates a system restart, 
in which all programmed parameters are valid.

GAIN### - gain change event 

Below is a description of all the different event stamp types ## which could be encountered. Some of these are quite 
common, while others indicate very rare fault conditions. Some may also occur together in various combinations, with 
no sample data between them.

Error## code comment

00 eDATA_ERROR_CATCH_ALL generic/unknown/unexpected error

01 eDATA_ERROR_EOC A/D *EOC bit was set (should always = 
0)

02 eDATA_ERROR_DMY A/D *DMY bit was set (should always = 
0)

03 eDATA_ERROR_MODULE_ADDR invalid address used for RBR channel

04 eDATA_ERROR_OVERFLOW too much data to send to front end

05 eDATA_ERROR_BUS_BUSY access to internal bus denied
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06 eDATA_ERROR_TX_FAIL timeout sending command

07 eDATA_ERROR_RX_TIMEOUT timeout receiving response

08 eDATA_ERROR_PARSING generic failure to interpret response

09 eDATA_ERROR_NO_SAMPLE no sample was started

10 eDATA_ERROR_IN_PROGRESS sample acquisition still in progress

11 eDATA_ERROR_FAILED sample process failed somewhere

12 eDATA_ERROR_AVERAGE average computation error (no valid 
samples)

13 eDATA_ERROR_REPLY_SHORT front end reply contains fewer 
characters than expected

15 eDATA_ERROR_UNABLETOCOM
PUTE

unable to compute derived/cross 
channel
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